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Call to Order

and Logistics

Ken Ambrose, Senior Advisor, CDO Council
General Services Administration (GSA)




Welcome

> This meeting is being recorded and will be posted to
CDO.gov when it is available.

» This meeting includes ASL interpretation and captions.
Please see the Eventbrite email you received for the link
to view the captions.

> Attendees will be able to provide comments through
the Request For Information (RFI). The un-mute and
chat functions are not enabled in this meeting.

> |If you have any technical issues or questions please
email cdocstaff@gsa.gov.




Federal Chief Data Officers (CDO) Council
Meeting Agenda

Agenda Topics Time (PM)

Call to Order and Logistics 1:00 - 1:05

Welcome from the Office of Management Budget (OMB) 1:05 - 1:15
CDO Council Introduction, Priorities, and Accomplishments 1:15 - 1:45
Break (5 minutes) 1:45 - 1:50
Working Group Presentations 1:50 - 2:50
Panel of Large and Small Agency Chief Data Officers 2:50 - 3:20
Break (5 minutes) 3:20 - 3:25
3:25 - 3:55

Evidence Act Councils Data Collaboration Presentations
Introduction to the Request for Information (RFI)
Closing Remarks

3:55-4:05
4:05-4:10



Welcome from
the Office of
Management
Budget (OMB)

Maria Roat, Deputy Federal CIO
OMB/Office of the Federal Chief Information Officer
(OFCI0)

Dominic Mancini, Deputy Administrator
OMB/Office of Information and Regulatory Affairs
(OIRA)
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CDO Council
Introduction,

Priorities, and
Accomplishments

Ted Kaouk, CDO Council Chair
Office of Personnel Management (OPM)




Chief Data Officer Council Overview

» Authorization

Established by the Foundations for Evidence-Based
Policymaking Act of 2018

» Vision
To lead transformational change that improves the nation’s
ability to leverage data as a strategic asset

> Membership

All agency-level CDOs are members (including Large and
Small agencies)




Purpose

> Establish government-wide best practices for the use,
protection, dissemination, and generation of data

> Promote and encourage data sharing agreements between
agencies

> ldentify ways in which agencies can improve upon the
production of evidence for use in policymaking

> Consult with the public and engage with private users of
Government data and other stakeholders on how to improve
access to data assets of the Federal Government




Foundations

> Commission on Evidence Based Policy Making (2017)
> Foundations for Evidence Based Policy Making Act of
2018 (P.L. 115-435)

> Federal Data Strategy 2020
> Advisory Committee on Data for Evidence Building




Components of Evidence

> Policy Analysis: Analysis of data, such as general
purpose survey or program specific data, to generate
and inform policy

> Performance Measurement: Ongoing systematic track
of information relevant to policies, strategies,
programs, projects, goals, and activities

> Foundational Fact-finding: Foundational research and
analysis such as aggregate indicators, exploratory
studies, descriptive statistics, and basic research

> Program Evaluation: Systematic analysis of a program,
policy, organization, or component of these to assess
effectiveness and efficiency

OMB Memo M-19-23, “Phase 1 Implementation of the Foundations for Evidence-Based Policymaking Act of 2018:
Leaming Agendas, Personnel, and Planning Guidance



What is a Chief Data Officer?

CDOs enable data driven decision-making in a variety of ways,
including:
» Developing and leveraging centralized agency analytics capacity
» Creating tools and platforms that enable self-service across their
agencies and for the public
» Convening and coordinating agency-wide data governance activities
» Coordinating with any official in the agency responsible for using,
protecting, disseminating, and generating data to ensure that the data
needs of the agency are met
» Engaging agency employees, the public, and contractors in using public
data assets, and encouraging collaborative approaches on improving
data uses

» Supporting the Evaluation and Performance Improvement Officer of the
agency in identifying and using data to carry out their functions

> Ensuring effective lifecycle data management

> Improving data infrastructure



Council Goals

> Meet statutory requirements, including the required report
to Congress

> Be acommunity of learning by broadly identifying best
practices and resources to facilitate the implementation of
Evidence Act

> Provide leadership on the delivery of the Federal Data
Strategy (FDS) Action Plan




Council Structure

Executive Committee

CDOC Chair i((j;n?l:/ri;?rrgt?)rr]t OIRA et
Administrator Group

Chairs

Small Agency (While

CPOC Vice Char Large Agency Rep Active)

CDO Council

OIRA E-Government
Agency CDOs Administrator Administrator

Working Groups, Standing Committees, Communities of Practice

- Data Data Data Small Large
Ope\:/r\?(gons Inventory Skills Sharing Agency Agency
WG WG WG Committee Committee
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Federal Data Strategy Agency Actions

Action 1: Identify Data Needs to Answer Priority Agency Questions
Action 2: Constitute a Diverse Data Governance Body

Action 3: Assess Data and Related Infrastructure Maturity
Action 4: |dentify Opportunities to Increase Staff Data Skills
Action 5: Identify Priority Data Assets for Agency Open Data Plans

Action 6: Publish and Update Data Inventories




CDO Council Focus Areas

v

Workforce Data Skills

v

Data Sharing

v

Data Inventories

v

Stakeholder engagement




FY 2021 Activities & Initiatives

Develop a vibrant learning e  Host regular information sharing sessions to
community to ensure that exchange and develop best practices
CDOs have the resources to ° Develop resources to enable CDOs to deliver value

lead data driven change ° Develop the CDO profession

° Identify and address cross-cutting data challenges
° Implement CDO Council public engagement &
communications plan

Demonstrate the Strategic
Value of the CDO COuncil

° Mature templates and standard practices

° Implement communications protocols for the
Council’s internal communications

° Develop the cross-council collaboration framework

Facilitate strategic
engagement across Federal
data activities

° Provide input on proposed Federal data policies
Develop Efficient and e  Provide strategic input to the Advisor Committee on
Effective Operating Model for Evidence Building

the CDO Council e  Engage and collaborate with other data-related
Councils




Work to Date

» Workforce Projects
> Data Skills Catalogue and Toolkit
> Federal CDO Data Skills Training Program Case Studies
> Data Scientist Subject Matter Expert Qualifications
Assessment (hiring over 40 data scientists!)
> Successfully onboarded a class of 20 CXO Data Fellows

» Data and Analysis projects
> Wildland Fire Fuels Project
> Public Comment Analysis
> Federal Cross Agency Dashboarding Project
> Completed work for the COVID-19 Data Sharing Working Group

» Council Implementation
> Creation of infrastructure for a brand new council
> Report to OMB and Congress
> Laying the groundwork for cross council collaboration




Break (5 minutes)

Agenda Topics Time (PM)

Working Group Presentations 1:50 - 2:50

Panel of Large and Small Agencies Chief Data Officers 2:50 - 3:20
Break (5 minutes) 3:20 - 3:25
Evidence Act Councils Data Collaboration 3:25-3:55
Introduction to the Request for Information (RFI) 3:55-4:05

Closing Remarks 4:05 - 4:10



Break (1 minute remaining)

Agenda Topics Time (PM)
Working Group Presentations 1:50 - 2:50
Panel of Large and Small Agencies Chief Data Officers 2:50 - 3:20
Break (5 minutes) 3:20 - 3:25
Evidence Act Councils Data Collaboration 3:25 - 3:55
Introduction to the Request for Information (RFI) 3:55-4:05

Closing Remarks 4:05 - 4:10




Working
Group
Presentations
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Data Skills
& Workforce

Development
Working Group

Tom Beach, Data Skills & Workforce Lead
Department of Commerce (DOC)
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Background
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Data Skills Working Group

14% of CDOs Have Been in Their Roles for

Less Than a Year

Tenure in current role

1 to less than
3 years
50%

Less than a
year
14%

n = 469, All Respondeants

28 ® 2020 Gariner, Inc. andlor its afliabes AJ righits nesersed

3 to less
than 5
YEAars

23%

2 years and
more

13%

Gartner

Convergence of Data and Analytics Skills and Expertise

@

Data and
Analytics Skills

&

Business
Expertise

2]

IT Skills

+
A

Soft Skills

Gartner
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Data Skills Working Group

. L 2 *
» Data Skills to turn data ( -
into answers J S

» Data Skills to turn Data Creation Data Storage Data Use

answers into decisions
DATA LIFECYCLE MANAGEMENT

Bolh

T

» Data Skills to turn
decisions into actions

Data Sharing Archiving Destruction



Data Skills Working Group Goals & Objectives

@n
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Goal
Goal
» Facilitate the Council’s ability to : :
deliver value to CDOs and the);r > Enable effective and proactive
: communications between and
stakeholders to improve the among Council members
efficiency and effectiveness of data working groups, and
skills & workforce development committees.
efforts. Objective
Objective » Organize a Community of
» Create new knowledge base that Practice (CoP) as a convening
continuously fosters learning platform for members for

sharing, presenting and
dialoguing on experiences
related to data skills &
workforce development efforts.

through networking and sharing
experiences related to data skills &
workforce development efforts, and
workshops and engaging other
Federal stakeholders and platforms.



Data Skills Working Group Goal & Objective

Goal

» Focus on sponsoring continuous and competency-based skills and

workforce development resulting in improving data acumen and closing

skills/development gaps.

Objective

» Resourcing effort building a virtual Data Skills Catalogue; Case
Studies of existing programs in the Federal government and; the
development a toolkit/playbook on how a Federal organization can

develop a data skills and workforce development program.



Deliverables
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Case Studies

4 CDO

council

Data Skills
Training Program

CASE

STUDIES

This series was developed by the Chief Data Officer Council’s Data Skills &
Workforce Development Working Group to provide support to agencies in
implamenting the Federal Data Strategy’s Agency Action 4 gap-closing strategy
training co?nponent in Fy21

Contents

Case Study Key 3

HHS Data Science Colab 4

Air Force Public Sector Data Governance

Protessional Training Certification Pilot 9
CDC Data Science Upskilling Program 14
Census Bureau Data Science Training Pilot 19
Data Science @NLM Training Program 24
FDIC Data Literacy Pilot 29
NSF Data Science and Data Analytics Certification Pilot .. 33
Treasury/Internal Revenue Service Data Literacy Program.......... .38




Implementation Toolkit

fodoeral
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s+ CDO
council
Contents
Introduction
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Implementation Steps

Step 1: Conduct an Environmental Scan and

Data Skills | ‘ Data Skills Needs Assessmaent

Training Program 20 Step 2: Develop a Governance Structure with Key
Stakeholders 8Nd PartN erS . s issssissmsssisssssmiiis

IMPLEMENTATION 1L j Step 3: Plan for an Appropriate Level of Funding for

Your Data Skills Training Program

TOOLKIT

Step 4: Start Your Federal Acquisition Planning and
Procurement Process

Step 5: Design the Key Companents of

Your Dala Skills Training Program

Step 6: Develop a Strategic Communications Campaign o
Federal Chief Data Officers (CDO) Council Drive Engagement and Gain Multiple Stakeholder Buy-In.....
Data Skills & Warkforca Development Warking Group
Step 7: Pilot Your Data Skills Training Program and

June 202]
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CDO Playbook - the Four Plays: Play #1

1. Cultivate strong relationships to partner on solving mission
problems through data - building relationships, stakeholder
engagement, and stakeholder influencing

Key Highlights:

> Realize near-term value opportunities by establishing partnerships.

> Influence key stakeholders on value-driven solutions.

> CDOs should focus on forging relationships first before zeroing in
on data governance activities that may risk appearing to be just
compliance driven.




CDO Playbook - the Four Plays: Play #2

2. Promote data sharing and break organizational silos - establishing
data management processes to enable data sharing

Key Highlights:

> Implement a data stewardship model to breaks silos across agency

offices.
» Partner with stakeholders on pilot projects to gain “quick wins”.

> Establish a data management program to foster better transparency
and agency collaboration.

> Metadata is important in building trust and enabling data sharing.




CDO Playbook - the Four Plays: Play #3

3. Build a data-driven culture by taking the lead to improve data
literacy within your agency - transforming the workforce and
overall organizational culture

Key Highlights:

» Focus on education and awareness, communicating the
importance and value of data throughout the organization.

» Investin the individuals within your workforce, providing an
Inclusive approach to building and harnessing basic data skills,
knowledge, and competencies in all staff.

> |dentify future roles needed to fill skill gaps.




CDO Playbook - the Four Plays: Play #4

4. Drive transformation through a mission-focused data and
analytics strategy that can influence the enterprise-wide business
strategy - developing a modern, effective, mission-focused data and

analytics strategy that delivers tangible mission outcomes and value
In the immediate and long term

Key Highlights:
» Collaborate with key stakeholders in strategic planning activities.

» Link data specific resource allocations or investments to the key

business problems and objectives that are core to your data and
analytics strategy.

» Focus on how to transform the organization and in turn influence
and transform your mission objectives and business strategy.
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Data Inventory

Working
Group

Tod Dabolt, Data Inventory Lead
Department of the Interior (DOI)



Public access to and preservation of knowledge are
cornerstones of democracy

|||||||||||

Construction of the Library of Congress,
Washington, D.C., April 19, 1893



Federal Open Government Data Act -

» Government Data should be OPEN by default unless
protected by statute

» Open Government data assets are a public data that
are:
> machine-readable

> available (or could be made available) in an open
format

> not encumbered by restrictions, other than
intellectual property rights

> based on an underlying open standard

> All Agencies must maintain a comprehensive data
iInventory




Data Inventory Working Group Goals & Objectives

’ “What questions “Wh i
at constraints are « sy tao
é‘ .Should/could a data (Z‘there?” (3‘ How ShOUId we fix 1t?
Inventory answer?” - - _ ,
Identify solutions and
recommended actions to
maximize data inventories

value while minimizing

Document data inventory

Create comprehensive list of challenges and opportunities

data inventory use cases at

rederal agencies > Legal and or Policy compliance burden

» Purposes within the challenges
Federal government and > Data challenges » Legislative and Policy
across levels of » Technical challenges (e.g., Changes
government cross Department's » Best or Promising

manti :

> Linkages with: N ?DZpaaci’tyCiallenges (eg. Practices
Performance; PRA, FOIA Knowledge gaps: > Input to OMB; CENDI
CUl; Privacy; Security, R P FGDC/Geoplatform;

. . institutional) GSA/Data.sov

Records; Portfolio g

Coordinate councils & integrate open data working group



Why do data inventories matter?

» |Informed Decisions
> Transparency
» Trust

And they are required by law - 44 U.S. Code § 3511




Stakeholders

» Internal » Commercial
- Data Analysts > Regulated Entities
> Management » Tech/Data Sector

> Compliance /Oversight

» Public » Non-Governmental

> Journalist Organizations
> Students / Educators

> Scientists
> State/Local/Tribal




Overarching Requirements

» Ability to find relevant data to answer questions
> Ability to quickly fuse data with other data

> Ability to easily document how they answered their
question

Users don’t want:

» To search multiple platforms

> Learn more interfaces

» Maintain multiple Identities / Roles

» To be constrained to a specific product




Challenges agencies face when maintaining
data inventories

> Volume of Data
» Search and Discovery

> Interoperability




Exponential Growth

» "The amount of digital data created over the next five
years will be greater than twice the amount of data
created since the advent of digital storage?“ - Dave

Reinsel, senior vice president, IDC's Global DataSphere

> And if stored - how will analysts ever find what they

need to best inform policy?




Can't we just use commercial search?

-

CENTER FOR SCIENTIFIC
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Silos and Interoperability

» Datasets are everywhere (cross platforms, cross organizations)
» Catalogs are highly distributed and rarely integrated

» Metadata - Standards, Completeness, Accuracy

» Semantics - what does the data mean?

> Most data isn’t machine to machine ready
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Data Sharing

Working
Group

Dan Morgan, CDO Council Vice-Chair
Department of Transportation (DOT)
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Context

mmm UNprecedented challenges in society
Collaborative

Sharing across the government

mmw Driven by action




Charter

> Create comprehensive list of data sharing purposes and use cases at

Federal agencies (WHY do agencies share data and WHO do agencies
share with)

> Document data sharing challenges (WHAT constraints are there?)
> Legal challenges
> Policy challenges
> Technical challenges

> l|dentify solutions and recommended actions that would make sharing
easier with strong privacy protections (HOW should we fix it?)



Near Term Work

Gathering

e Literature Review

- Use Cases

Defining

- Challenges and
Opportunities

« CDO Council
Request for
Information

Writing

- Data Sharing
Culture

- Summary of
Findings and
Way Ahead




Use Case Approach

> Name of federal agency

» List of actors or who the data was shared with (federal to federal,
federal to state, etc.)

» Name of data project
> Authorities
> Methodology - Process for determining sharing
> Descriptions:
> Of the context for the use of the data
> Of the objective, issues to be studied, benefits, methods
> Of any other data that will be linked, matched, or used

» Key takeaways/lessons learned
» Standards, Processes, Recommendations Learned from Use Case

» Successful/Failure




Input Needed

» Best practices for statistical and non-statistical agency partnerships

» Models for developing and using privacy-protecting identifiers, with
supporting policy

» Examples of thriving data sharing efforts and why they work

» Suggestions for ways we can facilitate private sector data sharing
across multiple agencies



i CDO

council

Operations Working
Group

Melanie Carter, Operations Lead

Pension Benefit Guaranty
Corporation (PBGC)
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Background

The Operations Working Group (OWG) supports the goals of
the CDO Council by supporting the core operations and
Implementation of the Council.

The OWG was established with the primary purposes of
developing operating and decision-making processes for
efficient and effective CDO Council operations; and
supporting the Executive Committee in handling issues
that require rapid response or pre-deliberation.

The chair of the OWG is an elected member of the group
and an established agency CDO who also participates on
CDO Council communicating essential information to the
Executive Committee.




Accomplishments

>

Developed by-laws for the CDO Council to provide guidance
for decision-making procedures, meeting cadence, working
group reporting procedures, and other key internal
operations.

Developed communication tools such as the CDO Talking
points, norms and processes as well as template documents
for the CDO Council and working groups.

Created a CXO Fellows selection procedural process to select
for the first time in the program, 20 fellows for the CXO
Fellowship Program in the category of data.

Facilitated operations the Executive Committee to
coordinate with the Federal Data Strategy team, additional
government councils, and other groups focused on data
activities.

Captured high-level recommendations resulting from the
CDO Data Equity Survey for the Equity Data Working Group.




Accomplishments Cont.

> Developed and distributed CDO Questionnaire to CDO
Council members to update and set standards for
Speakers Bureau table

> Finalized the Stakeholder Engagement Report

> Developed a template for all working group and
committee products/data to ensure an established
standard/process for material before release

> Provided recommended meeting agenda topics for the
Executive Committee and/or other working groups

> Implemented changes to the CDO Council website based
on feedback




Current Activities

> ldentify additional leadership opportunities for CDOs to
contribute to working groups

» Establish opportunities to strengthen the networking
experience and engagement between CDOs

> ldentify the key components of the executive orders in
which CDOs must respond and act

> Refine the program information and conceptual areas
that have been developed for CDOs




Future Focus

> Plan and prepare Council members for the public
meeting with stakeholder analysis using best practices
for holding a public meeting
> Establish a road map for CDOs in 2022 to provide a
layout of planned activities and goals to include
> Developing a CDO conference/bootcamp
> |dentifying training and networking opportunities
to support current and future efforts




Panel of Large

and Small
Agency Chief
Data Officers
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Kshemendra Paul Kirsten Dalboe

Large Agency Committee Leader Small Agency Committee Leader

Department of Veterans Affairs (vA) Federal Energy Regulatory Commission (FERC)

David Spirk Tammy Roust

Large Agency Committee Rep. Small Agency Committee Agency Rep.

Department of Defense (DoD) Commodity Futures Trading Commission (CFTC)



Break (5 minutes)

Agenda Topics

Evidence Act Councils Data Collaboration

Introduction to the Request for Information (RFI)
Closing Remarks

Time (PM)

3:25-3:55
3:55-4:05
4:05 - 4:10




Break (1 minute remaining)

: ; ) 3:25-3:55
Evidence Act Councils Data Collaboration

| _ 3:55 - 4:05
Introduction to the Request for Information (RFI) 4:05 - 4:10
Closing Remarks | |



Evidence Act

Councils Data
Collaboration
Presentations
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William W. Beach
Interagency Council on Statistical Policy (ICSP) Chair
Bureau of Labor Statistics
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Bureau of Labor Statistics




What's in Title 11l of the Evidence Act? HELLO

MY NAME IS

Statistical Official

7~ Y

CIPSEA




Where will we get our data?




What is the workplace of the future?




Data sharing and confidentiality




Contact Information

William W. Beach
Commissioner of Labor Statistics
Bureau of Labor Statistics
www.bls.gov

Beach.William@bls.gov




Evaluation
Officer Council

Diana Epstein
OMB Evidence Team Lead
EOC Chair

A



Components of Evidence

Policy Analysis

Program Evaluation

Foundational Fact Finding

Performance Measurement

Evaluation

“Systematic analysis of a program, policy, organization, or component of
these to assess effectiveness and efficiency”

Analysis of data, such as general purpose survey or
program-specific data, to generate and inform policy,
e.g., estimating regulatory impacts and other relevant
effects

Systematic analysis of a program, organization, or
component of these to assess effectiveness and
efficiency

Foundational research and analysis such as
aggregate indicators, exploratory studies, descriptive
statistics, and basic research

Ongoing, systematic tracking of information relevant
to policies, strategies, programs, projects,
goals/objectives, and/or activities



EOC Priorities for FY22

> Complete and publish Evidence Act Title | deliverables
> Learning Agenda
FY23 Annual Evaluation Plan

v

>  Capacity Assessment
>  Agency Evaluation Policy

> Begin to implement studies prioritized in Learning Agendas and
Annual Evaluation Plans

>  Evaluation Officer role in other new priorities
> Advancing Racial Equity Executive Order
>  PM on Advancing Scientific Integrity and Evidence-Based
Policymaking
> American Rescue Plan programs

> Build evaluation capacity

>  Foster external partnerships



Collaboration Opportunities

Within an agency, partner to leverage data for priority studies in
Learning Agenda and Annual Evaluation Plan

Agency connections around common Learning Agenda priorities

Identify promising opportunities to link data across agencies for
statistical or evaluation purposes, consistent with priorities in
Learning Agendas and Annual Evaluation Plan

Continue building agency culture of, and capacity for, evidence-based
policymaking

Understand and address agency data skills gaps

Leverage existing processes and integrate requirements to build
efficiencies and embed Evidence Act work



Please get in touch!

» evidence@omb.eop.gov
- https://www.evaluation.gov

»  https://www.whitehouse.gov/omb/information-for-
agencies/evidence-and-evaluation/




The Federal
Privacy
Council

Kirsten Moncada
FPC Chair
OIRA Privacy Branch Chief, OMB
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Trust

Transparency Accountability
Authority

Individual Participation Use Limitation

Purpose Specification
Minimization Security

Quality & Integrity Access & Amendment




Senior Agency Officials for Privacy

The SAOP Leads the agency’s
privacy program & is

responsible for:

» Ensuring compliance
with applicable privacy

requirements

> Developing and evaluating

privacy policy

» Managing privacy risk

> Privacy Law

> Privacy Policy

> FairInformation
OME Circular A-130 PraCtice PrinCiples
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The Federal Privacy Council

» Serves as the principal interagency forum of privacy
professionals across the Executive Branch to improve
government privacy practices by:

> better coordinating and collaborating on privacy issues
> developing and exchanging best practices

> educating the Federal workforce

» Coordinates with other Executive Branch interagency councils

Established by Executive Order 13719
81 Federal Register 7687 (February 12, 2016)




Coordination in Data Governance!




Visit our website: fpc.gov




federal
||||

- CDO
Introduction to
the Request

for Information

(RFI)

Dan Morgan, CDO Council Vice-Chair
Department of Transportation (DOT)



Purpose and Overview

>

Request input on key
questions to support the
council’s mission and

focus areas

Responses will be
shared with the relevant

groups in the Council

Topics

Working Groups

» Data Skills and Workforce
Development
> Data Inventory

> Data Sharing
Cross-cutting topics

> Value and Maturity
> Equity
> Technology




Instructions for Responding

Where: Available on CDO.gov and the Federal Register
When: Open until November 15, 2021
How: Reply though Regulations.gov

> Include your name and/or organization

» No more than 6 pages

» Specify which section(s) your submission is related to
» Include a contact for questions or follow-up




Tips for an effective response

> You don't need to answer every question, but specify
which question you're answering.

» Yourresponse can link to papers or other materials
that support the theory behind the question.

» If you disagree with a focus area or proposed topic,
suggest an alternative. Include an explanation or
analysis of how the alternative will advance the CDO
Council's work.

» Address trade-offs or opposing views in your response.




Closing
Remarks

Ted Kaouk, CDO Council Chair
Office of Personnel Management (OPM)
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Thank you for attending the CDO
Council’s first Public Meeting!

Please visit our website at cdo.gov.

We anticipate posting a recording of
this meeting on our website, as well
as a link to the RFL.




